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to resize the actual image; it merely adjusts the screen view. The two images on-screen 

should now look something like figure 8.3.

Click on the original image to make it active and go to View>Proof Setup>Custom. This 

will bring up the dialog box shown in figure 8.4.

Here is where you make your choices for soft proofing the image. They will be the 

same choices you make later when you output the print. In my example, the Device to 

Simulate option is set to Pro38 USFAP, which is the profile for Epson UltraSmooth Fine 

Art Paper on the Epson Stylus Pro 3800 printer. When it comes to the choice of Render-

ing Intent, you’re going to be selecting either Relative Colorimetric or Perceptual. I set 
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p Figure 8.3: Original and copy images 

side-by-side on-screen

u Figure 8.4: Proof Setup dialog box
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the Rendering Intent to Relative Colorimetric. I’ve checked the box to turn Black Point 

Compensation (BPC). (The sidebar on page 129 explains BPC as well as each of the four 

Rendering Intent settings.)  

Under Display Options (On-Screen), is a check box for Simulate Paper Color. This ad-

justs the image to show you a preview of what the image will look like on a given paper. 

It will apply any hue or warm or cool tone the paper has, and will more accurately show 

the dynamic range of the printed image. When you soft proof, turn this option on by 

checking the box as I have done. After you’ve made all your selections, click OK to close 

the dialog box. You’ll see that your image will change to something that looks pretty ugly. 

That’s alright. We’re going to fix it.

The visual match will typically be closer with hard papers than with soft papers. The 

paper in this case, UltraSmooth Fine Art, is what I call a soft paper. It isn’t going to re-

produce blacks as deep or whites as bright as a hard paper would. If I had chosen a hard 

paper such as Epson’s Ultra Premium Glossy, the difference between the two versions 

would be smaller.

The goal now is to make adjustments to the proofed original to make it look as close 

as possible to the unproofed copy. You’re rarely going to get the two to look identical. 

You should still make adjustments at this stage as layers, so that you can delete or alter 

them in the future as needed. I added Curves and Hue/Saturation adjustment layers 

to the proofed version. The final proofed version with adjustments is shown in figure 8.6.

Soft Proofing

p Figure 8.5: Soft proofed original 

(right), and unproofed copy (left)
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You can see that the two are still not exactly the same, but they’re now closer. As noted 

above, it’s rare to get the two to match exactly. This is another reason why the goal of 

color management is not to get an exact match between your print and what you see 

on-screen, but you try to get as close as possible.

The next two layer stack screenshots (figures 8.7 and 8.8) show the adjustment layers 

I applied for printing and the layer group I created for those adjustment layers. Printing 

adjustments to an image are going to be specific to the paper, printer, and rendering 

intent. In some cases even the printing resolution will make a difference. Some profiles 

are also made for viewing under specific lighting conditions. In the future, if you use a 

different paper, printer, rendering intent, resolution, or profile that is built with a differ-

ent lighting condition, your proofing adjustments will be different. Grouping adjustment 

layers and naming the group so you know what it is allows you to prepare the same im-

age for printing in multiple ways by simply turning off or on the visibility of one of the 

printing adjustment groups. If you wish, you can include your output sharpening layer in 

this group too. Remember that the output sharpening will be different for hard and soft 

media, so including it in the proofing adjustments makes some sense.

In this case, I named the group for the printer (Epson 3800), the paper (USFAP), the 

rendering intent (Perceptual), and the printing resolution that will be used (1440 dpi). 

Some papers use different profiles for different printing resolutions, so including that 

information in the layer group name can be helpful.
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p Figure 8.6: Adjusted soft proof original 

(right) and unproofed copy (left)
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Soft Proofing

p Figure 8.8: Printing adjustment layers grouped and 

named for the paper, printer, resolution, and rendering 

intent

p Figure 8.7: Printing adjustment layers at the top 

of the stack
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Rendering Intents 

There are four different rendering intents. The rendering intent determines how out-of-

gamut colors are reproduced. What are out-of-gamut colors? They’re colors that are out 

of the range that can be reproduced by the paper and ink in a print. The color gamut of 

the paper and inkset is the universe of colors that they can reproduce. Rendering intent 

only matters for practical purposes when printing. When we switch from one editing color 

space to another (e.g., Adobe RGB to sRGB), the rendering intent is relative colorimetric 

by default. This will change as what are called Version 4 ICC profiles become more widely 

used, but with the use of Version 2 profiles, the intent is relative colorimetric. 

ICC stands for International Color Consortium. This international body develops the 

specifications for producing color profiles and makes recommendations for how color pro-

files should be used in color-managed workflows. These broader color spaces, called work-

ing color spaces, are referred to as device independent. That is, they are the same regard-

less of where the image is being viewed. The color space of a printing paper or a monitor, 

which is called an output color space, is referred to as device dependent. That is, the color 

space is entirely dependent on the ink/paper combination or the specific monitor.

Relative colorimetric: All of the out-of-gamut colors are remapped to the closest in-

gamut colors. If we have a particular red that is 150, 25, 25, and another that is 175, 20, 

20, and both are out of gamut for the particular ink/paper combination and the closest 

in-gamut color is 125, 55,55, then both of these out-of-gamut reds will get reproduced as 

the same in-gamut red. What this can cause with a lot of out-of-gamut colors is an increase 

in saturation of some colors at the outer limits of the gamut. What also happens with rela-

tive colorimetric is that the white point of your source image gets remapped to the white 

point of the destination paper. In other words, white stays white, as much as possible. If 

your paper has a warm tone, the white of your image will become the warm tone of the 

paper in your print.

Perceptual: The perceptual rendering intent remaps all of the colors in an image, both 

in-gamut and out-of-gamut, so that the relationships between the colors remain as close 

as possible. This can sometimes cause a small decrease in overall color saturation, but be-

cause the relationships between colors are maintained, the perception of color and satura-

tion stays pretty much the same. Perceptual is a good starting point for soft proofing and 

printing. If you try perceptual and don’t like how it looks, switch to relative colorimetric 

and see if it works better.
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u Figure 8.9: Out-of-gamut color map-

ping with the relative colorimetric render-

ing intent. In-gamut colors don’t change, 

and out-of-gamut colors get remapped 

to the limit.
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Absolute colorimetric: This rendering intent remaps out-of-gamut colors in the same 

way as relative colorimetric. What it doesn’t do is remap the white point. Absolute colori-

metric will overlay the color of the paper you’re proofing with onto the paper you’re print-

ing on. You’re already doing that visually by selecting Simulate Paper Color in the proofing 

dialog. If you print with absolute colorimetric to a warm-toned paper, for example, the 

warm tone of the paper will be printed onto the warm-toned paper, doubling the effect. 

Absolute colorimetric is good to use if you’re simulating another device, such as a printing 

press, and you know you’re going to be printing onto a paper that has a different base 

from what you’re creating your proof on. This is a very specialized case and not one we 

want to use for photo printing.

Saturation: The saturation rendering intent remaps all of the out-of-gamut colors to the 

closest in-gamut color. This sounds the same as relative colorimetric, right? What the satu-

ration intent also does is remap some in-gamut colors closer to the limit. This can cause 

a marked increase in overall saturation. Saturation also doesn’t necessarily remap colors 

into the same color family. It remaps according to saturation levels. If you have a red that 

can’t be replicated but there’s a yellow that has the same saturation level, your red may 

get remapped to yellow. Not good.

Black point compensation: Applying BPC will be an image-by-image choice. The choice 

will be determined by how well the paper you’re using reproduces deep blacks and what 

the Dmax (the deepest black the paper can reproduce) of the paper is. BPC remaps the 

black point of the image to compensate for the ability of the paper to render deep blacks. 

With papers like the softer media, if BPC is left turned off, you may get a lot of blocked-up 

shadows. Turning BPC on will lighten some of those darker areas to retain as much shadow 

information as possible. Try it turned on and off to see which is better. The effects of hav-

ing BPC on and off can be seen in figure 8.11. The diagonal gray line represents an image 

with brightness values ranging from 0 (black) to 255 (white). No paper can print that full 

range. In this case, I’ve shown a sample paper with a black point of 45. That means any-

thing with a brightness value of 45 or lower will be rendered black on this paper. Referring 

back to the step wedge in chapter 1, we’ll lose Zone I and some of Zone II. To compensate, 

turning BPC on remaps the black point of the image to 45 and slightly lightens some of 

the other dark values to retain shadow detail. 

Soft Proofing

t Figure 8.10: Color mapping with the 

perceptual rendering intent. All colors get 

remapped relative to each other. The result 

is a compression of the entire color range 

of the image.
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Preserve Details Using BCP 

BPC has another purpose in general color space conversions. If you’re going from a color 

space with a deep black point to one with a less deep black point, you can get blocked-up 

shadows. You can also have the inverse. If you’re going from a color space with a higher 

black point to one with a lower black point, you can get shadow areas that appear washed 

out. Using BPC in these cases will preserve your blacks and shadow detail. In the first case 

it will do the same as with a print and lighten the areas appropriately to retain shadow 

detail. In the second case BPC will actually darken those areas further to keep them from 

appearing overly light, being washed out and reducing the contrast in your image. Note 

also that when you’re using the perceptual rendering intent, checking or unchecking the 

BPC box will make no difference. The reason for this is that with the perceptual intent, BPC 

is always turned on by default.

CHAPTER 8 | Printing in the Digital Zone System

u Figure 8.11: Effects of having BPC on 

and off
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Soft Proofing

Why Use A Wide Color Space?
Recalling the color space gamut charts from chapter 2 and comparing the charts of paper 

color gamuts earlier in this chapter, you might be wondering why I’ve suggested working 

with a wide color space such as ProPhoto RGB when not all of the colors can be repro-

duced in a print. For reference, the next color gamut plot shows the difference between 

ProPhoto and Epson Exhibition Fiber, which is a paper with a very good color gamut.

There are a lot of colors in the ProPhoto space that aren’t reproducible on this paper 

with the inks of the Epson 3800 printer. But look what happens when we compare the 

same paper on a newer printer with a newer inkset. The color gamut of the paper is larger 

with the Epson Stylus Pro 7900 printer and a newer inkset. How can this be? Technol-

ogy changes. Technology improves. Just as digital cameras have become better over the 

years, so have printers and inks. Newer inks allow for greater levels of color even on the 

same paper. The main reason I suggest using ProPhoto is for future proofing. Because 

technology is always changing and improving, I want to be ready to take advantage of 

the new technology when it’s available. If I used Adobe RGB I would have to go back and 

rework all of my old images, which would require a lot of wasted time and energy. Work 

smarter, not harder. Think ahead and try to take advantage as much as possible of what 

may come in the future.

Here is another reason I suggest ProPhoto RGB: Adobe RGB is too small in some cases 

even now. The two plots in figure 8.14 show Adobe RGB compared to Epson Exhibition 

Fiber paper on the Epson 3800 printer and the same paper on the Epson 7900 printer. 

Even with the 3800, the paper/ink combination can reproduce more colors in some areas 

than the Adobe RGB space contains. The problem gets even worse on the 7900 printer. 

Why give up color in your prints if you don’t have to?

p Figure 8.12: Color gamut comparison. 

ProPhoto RGB (darker/larger plot), and 

Epson Exhibition Fiber paper (brighter/

smaller plot).

p Figure 8.14: Color gamut plots of Adobe RGB (dark plot) and Epson Exhibition Fiber 

paper (bright plot). This identical color space and paper shown on an Epson 3800 

printer (left) and an Epson 7900 printer (right).

p Figure 8.13: Color gamut comparison. 

Exhibition Fiber paper with the Epson 

7900 printer (darker plot) and the Epson 

3800 printer (brighter plot).
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Soft Proofing

See Which Colors are Out-of-Gamut
Photoshop’s View>Gamut Warning option (figure 8.15) will let you see which colors in 

your image are out of gamut for the paper you’re soft proofing and the inkset being used.

This is an interesting utility that lets you see the specific areas of the image that aren’t 

going to reproduce accurately in the print. You don’t need to do anything to fix the out-

of-gamut colors because the rendering intent will do it for you. The gamut warning just 

shows you which colors and parts of your image will be affected by the rendering intent. 

Some photographers like to fully or partially fix the out-of-gamut colors themselves. 

They feel it gives them more control over the final result. Should you choose to make 

adjustments to bring more or all of the colors in-gamut, you can do this in your printing 

adjustments layer group. Create a new Hue/Saturation or Vibrance layer, label it appro-

priately (e.g., Color Gamut Adjustment), and then adjust the colors to reduce saturation, 

adjust brightness, or alter hue to bring the colors into the gamut of the paper. The default 

color for the warning overlay is gray, but gray can sometimes be difficult to see. You can 

change the overlay color to anything you like by going to Edit>Preferences>Transparency 

& Gamut (Photoshop>Preferences>Transparency & Gamut). 

I chose a magenta color because it’s easily visible and not likely to show up in an im-

age. One thing the gamut warning does not do is show the intensity of the out-of-gamut 

colors. That is, the overlay is not denser in areas of greater out-of-gamut color. This would 

be a nice change on the part of Adobe and would make the utility even more useful.

When you’re comparing your prints to what you see on-screen, it is important that you 

compare the print to your adjusted soft-proofed image and not the original image. 

t Figure 8.15: Photoshop gamut warning
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